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1 Introduction

This is a user guide for the Qwizdom Connect.  This guide provides information and tips on
using Qwizdom Connect.

If you need assistance, please contact Technical Support.

Website www.qwizdom.com

Tech Support (253) 770-1285

Email support@qwizdom.com

Support Hours 6 a.m. to 4:30 p.m. PST

Address Qwizdom, Inc.
12617 Meridian East
Puyallup, WA  98373

Some map images are derived from maps © 2006. Map Resources, Lambertville, NJ 08530 www.mapresources.com

2 Getting Started

Contents of Remote Set
Q2RF, Q4RF, or Q5RF Remotes*
1 RF Host
1 Q5RF Instructor Remote
1 USB Cable
1 Charger (Q5RF Instructor Remote)*
1 Multi-charger (Q5RF Remotes)*
1 Screwdriver
AA Batteries (Q4RF) or AAA Batteries (Q2RF)*
1 Remote Carrying Case
1 Quick Reference Guide**
1 Software; Qwizdom Connect

*Remote types and accessories based on actual order. This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.
**Full user guide is located on the disc and at www.qwizdom.com.

2.1 Notice

Notices of Compliance for Qwizdom's RF Response Devices

http://www.myhomepage.com/index.html
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Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, users and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on  circuit different from that to which the

receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help.

Caution: Changes or modifications to Qwizdom's RF hardware that are not expressly
approved by Qwizdom could void the user's authority to operate the equipment.

This product is designed for the 2,4 Ghz WLAN network throughout the EC region and Switzerland with restrictions in France.

2.2 Installing Qwizdom Connect

System Requirements
Windows XP and later with Service Pack 2
Microsoft PowerPoint 2003 or later (registered version)
Microsoft Excel 2003 or later (registered version)
Microsoft .NET Framework 3.5 (included in installer)
Intel Pentium 1Ghz
1G of RAM
5 GB of disk space
CD-ROM drive
Open USB Port

Installing Qwizdom Connect
1. Insert the Qwizdom Connect disc into the CD-ROM drive.  The Qwizdom Connect

wizard will appear.
2. Click on Next.  The Select Installation Folder section appears.
3. You have the option to select the location of where you would like the Qwizdom

Connect or use the default location.
4. Click on Next to begin the installation.  This will take a few moments.
5. Once the installation is complete, click on Close and restart your computer.
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2.3 Hardware Setup

1. Plug the USB cable into the RF Host and then plug the other end of the USB cable
into an open USB port.

2. Place two AA batteries (provided in the remote set) and insert the screw (optional)
into the back of the Q4RF remote to secure the battery compartment; or place two
AAA batteries (provided in the remote set) and insert the screw (optional) into the
back of the Q2RF remote to secure the battery compartment Plug the Q5RF
participant and Q5RF instructor remotes into the multi-charger and/or single
charger for 24 hours before first use.

Installing USB Drivers on Vista
You will need to do this procedure twice (because there are two drivers).

1. Insert the Qwizdom Connect disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to the Control Panel.
3. Click on Hardware and Sound.
4. Click on  Device Manager.
5. Select the option View Devices by Type under the View menu.
6. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and

Unknown or Other Devices.
7. When you find it, double-click on it and click on the Driver tab.
8. Click on the button that says Update Driver.  The installation wizard will appear.
9. Select "Browse Computer for Software Driver" and click Next.
10. Click on the Browse button.  A window appears.
11. Click on My Computer, click on the drive that Qwizdom Connect is in, and then find

the folder that says USB_Drivers.
12. Click OK and then Next.
13. When it's done installing, click on Close.  Repeat the above steps once more and

then restart your computer.

Installing USB Drivers on Windows XP
You will need to do this procedure twice (because there are two drivers).

1. Insert the Qwizdom Connect disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to the Control Panel or go to Settings and then Control
Panel.

3. Double-click on the System icon and click on the Hardware tab.
4. Click on the Device Manager button.
5. Select the option View Devices by Type under the View menu.
6. Qwizdom RF Host or Qwizdom USB Base should be located under Universal Serial Bus

Controllers, Ports and Unknown or Other Devices.
7. When you find it, double-click on it and click on the Driver tab.
8. Click on the button that says Update Driver.  The installation wizard will appear.
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9. Select "Install from a list or specific location" and click Next.
10. Select "Search for the best driver in these locations" and check the "Search removable

media" and "Include this location in search" boxes.
11. Click on the Browse button, click on My Computer, click on the drive that Qwizdom

Connect is in, and then find the folder that says USB_Drivers. (Do not open the
folder).

12. Click OK and then Next.  A prompt will appear that says the drivers have not passed
the Microsoft Windows Update testing, click on Continue Anyway and then Finish.

13. Repeat the above steps once more and then restart your computer.

3 Content Manager

Click on the  Content Manager button in the floating toolbar. Content Manager
opens. Content Manager displays all created and imported activities.

Create a New Folder

1. Click on the  New Folder button.
2. Enter a name for the folder and click on OK.
3. The folder appears in the Content Tree on the left.

Create a New Activity

1. Click on the  New Activity button.
2. Enter a name for the activity and click on OK.
3. The activity appears in the Content Tree on the left.

Create a New Answer Key

1. Click on the black arrow to the right of the  New Activity button.
2. Select "Create and Add Answer Key file" and enter a name.
3. Click on OK and the answer key will appear in the Content Tree on the left.
4. Double-click on the answer key file to launch the Answer Key window. See Answer Key

for more information.
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3.1 Importing and Exporting

Importing Activities (.QAP and .QZA)
1. Go to the File menu and select Import Activity or Archive. The Open window appears.
2. Select the File of Type: .QAP or .QZA to import.
3. Select the activity and click on Open. The activity will import into the Content Tree.

You can also drag and drop activities (.QAP, .QZA, .QAK) into the Content Tree.

Importing External Documents
1. Go to the File menu and select Import External Document. The Open window appears.
2. Select the file you would like to import and click on Open. The external document

will import into the Content Tree.

3.2 Printing

1. Select an activity and go to the File menu.
2. Select Print. The activity will print.

3.3 Standards

Installing Standards

1. Click on the  Settings/Preferences button in the Qwizdom Connect toolbar.
2. Click on the Standards tab.
3. Select your state standards in the Select State drop-down list.
4. Click on Download State Standards to download your state standards into Qwizdom

Connect.

Applying Standards

1. Click on the  Standards button. The Standards window appears.
2. Select the standard at the level you want to apply to the slide(s).
3. Click on Add and then Done.  The standards will appear in the Standards tab at the

bottom of the Content Manager window.

If the Standards Properties tab isn't displayed, go to the View menu and select
Properties.

3.4 Presentation

Presenting an Activity
1. Select an activity to present.
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2. Click on the  Present button. The Presentation Setup window appears.
3. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
4. Click on the Saved Results drop-down field and select how you would like to save the

results.
5. Select the options you would like available during presentation in the General, Login,

and Display tabs in the lower part of the Presentation Setup window.
6. Click on OK to begin the presentation.

Presenting Multiple Answer Keys
Feature coming soon.

Before presenting an activity using Qwizdom remotes, please see Presentation Setup to
learn about the presentation features.

1. Click on the  Present button.
2. The Presentation Setup window appears.
3. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
4. Click on the Saved Results drop-down field and select how you would like to save

the results.
5. Select the options you would like available during presentation in the General,

Login, Display, and Chart tabs in the lower part of the Presentation Setup window.
6. Click on OK to begin the presentation.
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7. Have the participants turn on their remotes.
8. Either the answer choices or a blank screen appears on the remote, depending on

the question type.
Here are a few things you may execute during presentation:

· Display the response chart by pressing the / key
· Display the private graph by pressing the zero key
· Randomly call upon a participant by pressing the Pick key

9. Go through the presentation until all the question slides are answered.
10. When you are unable to advance to the next slide, this means the presentation is

complete. Click on the Utilities button and select Exit.

3.4.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be
applicable.

General tab:
· Send Right/Wrong Feedback to Remotes after answering-remotes will receive a

check mark if answer is correct and an X if answer is incorrect. Remotes will receive
both a check mark and X if feedback is turned off to indicate that the response has
been received.

· Allow participants to change answer-checking this option allows participants to
change their answer for the question slide they are on.

· Override Points Value with Global Point value of "----" points-enter the new amount
of points that will be applied to the slide temporarily for that presentation.

· Timer-you can select no timer, use the time set within the slides, and global timer by
entering the number of seconds for all slides in the presentation.
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Login tab:
· Require Login by ID-checking this option will have remotes prompt participants to

enter their participant ID.
· Show Login Screen-displays the login screen so the instructor can view the

participants that are logging in.
· Add & Allow Unregistered participants-participants will be added to the participant

by logging in with their participant ID. This option must be checked when using an
Anonymous list. For the Anonymous list, participants will only log in with the session
ID.

· Deny Login After "----" minutes-logins after the set amount of time will not be
accepted.

Display tab:
· Show function toolbar (not needed if using Presenter Remote)-checking this option

will display toolbar with Response Chart, Pick, and Re-pose buttons.
· Display Response Indicator-this displays the percentage of the class that has

answered; double-click the percentage to convert to a fraction.
· Show 'Start/Stop' responding to questions indicator-clicking on Stop will pause the

presentation and responses will not be accepted. Clicking on Start reposes the
question.
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Chart tab:
· Automatically Show Correct Answer on Chart-checking this option will display

toolbar with Response Chart, Pick, and Re-pose buttons.
· Background Filename-selecting this option will allow you to select an image to

display as the response chart background.
· Select Graph Layout-select how the response chart will be displayed during

presentation.

Advanced Settings

Advanced Settings
· Allow Instructor to go back to a previous slide-checking this option allows the

instructor remote to move back to a previous slide.
· Reset Com-Port When Starting Presentation-this option is checked by default to

ensure the host activates when presentation begins.
· Ask for confirmation of User ID when not on list-the remote will prompt the

participant for the user ID again, if the participant is not in the participant list that is
loaded.

Advanced Hardware Settings
· Don't require "Send" on single key answers-the remote will automatically send the

answer once it has been entered.
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· Disable "Change UserID" menu during Login-hides the "User ID" option from the
menu.

· Disable "Change SessionID" menu during Login-hides the "Session ID" option from
the menu.

· Disable "Change UserID" menu during active Session-hides the "User ID" option
from the menu during presentation.

· Disable "Change SessionID" menu during active Session-hides the "Session ID"
option from the menu during presentation.

· Do not show what key was pressed on Q2's-does not show the key that is pressed
on the display.

· Turn off remotes on presentation end-automatically turns off the Q2RF and Q4RF
remotes when a presentation ends.

3.4.1.1 Presentation Settings

Presentation settings can be saved and loaded (onto the same computer or another
computer) into the Presentation Setup window of Actionpoint, Answer Key, and Question Bar
applications.

Saving Presentation Settings
1. In the Presentation Setup window, select the options you would like during

presentation.
2. Go to the File menu and select Save Settings. The Save As window appears.
3. Enter the name for the selected settings.
4. Click on Save. The settings will save as a .CFG file in the location you selected.

Loading Presentation Settings
1. In the Presentation Setup window, go to the File menu.
2. Select Load Presentation Settings. The Open window appears.
3. Select the saved settings file (.CFG) and click on Open.
4. The current settings in the Presentation Setup window will change to the settings

you selected to load.

3.4.1.2 Saving Results

All results are saved as an .QRX file but can be converted into a .CSV (Comma Separated
Values) file.

Manual Save

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Select Browse for Save Location.
3. Click on the  Browse button. The Save As window appears.
4. Select a location to save the results in.
5. Enter the name you want the results to be saved as.
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6. Click on Save. The file name and location will appear in the Save Results field.
7. The results will save in the selected location.

Auto-save

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Select Auto Save as 'Filename + List + Date.'
3. The Browse for Folder window appears.
4. Select the location and click on OK.
5. The file name will contain the location, name of the participant list, date, and time

under the Save Results field.
6. The results will save when the presentation is complete.

Auto-Save to Results Manager
You must be logged into Qwizdom Online to access this feature.

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Select Auto Save to Results Manager.
3. The results will save in the Results/Reports window when the presentation is

complete.

3.4.1.3 Remote Login

Logging in with IDs allows participants to use any remote.  If you use participant IDs from a
participant list, the ID will link the remote to the participant's information in the list.

To have participants log in, they must have a participant ID.  Participant IDs are setup when
creating participant lists.  (Go to Participant Lists for more information).  Each participant
should have a unique ID assigned to their name.

· Participant IDs can only be numeric.
· The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
· The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
· IDs cannot be used for more than one participant (IDs cannot be duplicated).

1. Select an activity or create one to present.

2. Click on the  Present button.  The Presentation Setup window will appear.
3. Select a participant list from the "Participant List" drop-down menu.
4. Click on the Login tab.
5. Check the "Require Login by ID" option.
6. Checking the "Show Login Screen" is optional.
7. Select all other preferred options and click on OK to present.  The presentation will

begin.
8. The remotes will display "User ID."
9. Participants will enter their ID and press the Send (double arrows) key.
10. Once everyone has logged in, begin the presentation.
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You can start the presentation as participants log in. Participants who are late, can log in
later if you have not set a timer to deny log-in.

Login Timer
You can deny login after a certain amount of time by setting the time under the Login tab.

1. Check the "Deny Login After ---- Minutes" option.
2. Enter the number of minutes that participants have to log in.

For example, you have select to deny log in after 5 minutes. After 5 minutes has passed,
participants who try to log in will be denied.

3.4.2 Presentation Features

Function Bar
The control bar has the Response Graph, Pick, and Re-Pose buttons.  To view the control bar
during presentation, select "Show Function Bar" in Display tab.

Response Graph

1. Click on the  Response Graph button.
2. The Response Graph appears.
3. Click on the available chart(s) to view the results.
4. Double-click on the title bar of the window to display the graph in full screen.

Picking Participants

1. Click on the  Pick button to randomly call up on a participant.
2.  The participant's name will appear on screen.

3. Click on the  Pick button again to remove the name.

Re-posing a Question
Re-posing is used to ask a question again and/or  when you accidentally skip a slide that
needs to be answered. Re-posing the question overwrites the previous responses if any are
recorded.

1. Click on the  Re-pose button to ask the question on the slide again.

Response Indicator
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The response indicator displays the percentage of participants that have answered.
In the Presentation Setup window:

1. Check the "Display Response Indicator" box in the Display tab.
2. In presentation mode, you can move the response indicator by clicking on it with

the mouse and dragging it to another area of the screen.
3. To change the indicator view, double-click on it to display responses as fractions.
4. Double-click again to change indicator back to percentage.

Start/Stop Indicator

The start/stop indicator resets the time and reposes the question.
1. Check the "Show 'Start/Stop responding to questions indicator" box in the Display tab

of the Presentation Setup window.

Timer
To view the timer during presentation, click on the Timer drop-down list in the General tab
to view the timer options.  Here are a few tips on using the timer:

· The timer has pause/play, stop, and add/subtract 5 seconds options.
· You can move the timer by clicking on it and dragging it to another area of the

screen.
· Remotes will not be able to answer when time is up.

You can set the timer two ways; use the time from each slide or apply a new time to the
presentation.  When you create a slide, you enter the amount of time you want the slide to
display for.
To set a new time to the presentation:

1. Click on the Timer drop-down list and select "Use Global Timer Value of----"
2. Enter the number of seconds.
3. Click on OK to present the presentation with the newly set time.

Points
You can set the point value two ways; use the point value from each slide or apply a new
point value to all the questions in the presentation.  When you create a slide, you enter the
number of points the correct response will be awarded.  Go to Creating a Slide for more
information.
To apply a new point value to all the questions in the presentation:

1. Check the "Override Point Value with Global Point value of ---- points" option.
2. Enter the number of points.
3. Click on OK to present the presentation with the newly set time.
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Right/Wrong Feedback
This allows participants to see if their response is right or wrong.

1. Check the "Send Right/Wrong Feedback to Remotes after answering" box in the General
tab of the Presentation Setup window.

Feedback will appear on the LCD screen of the participant's remote during presentation.  A
check mark will indicate a correct response, an X will indicate an incorrect response. If the
feedback is disabled, a check mark and X will appear on the LCD screen indicating that a
response was received.

3.4.2.1 Response Graph

During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
graph.

Public Response Graph
1. Press the / key on the RF instructor remote.
2. The response graph will appear on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the / key again to remove the response graph.

If you have a graph displayed, either on the instructor remote or computer, you
must first remove that graph before displaying the other graph and/or move onto
the next question.

Bar Chart
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Press circle key to show bars horizontally or vertically.

Pie Chart Displaying Correct Answer with Number of Responses

Pie Chart Displaying Correct Answer with Percentages
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Pie Chart Displaying Number of Responses

Pie Chart Displaying Number of Responses
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List View Chart

Scores Chart
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Private Response Graph
1. Press the 0 key on the RF instructor remote.
2. A bar chart showing the number of responses will display on the RF instructor

remote's LCD screen.
3. Press the 0 key again to remove the graph.

4 Live Editor

Click on the  Live Editor button in the floating toolbar. Live Editor opens. Live Editor
enables you to create slides to present within Qwizdom Connect.
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Editor Toolbar

 Slide navigator Pen tool

Create new question Line tool

I indicates Information slide Shapes tool

Q indicates question slide Text tool

Copies current slide as into slide set MathML

Poses selected slide Insert image

Deletes a selected object on the slide Insert multimedia

Undo/redo Color
palette

Selects objects on slide Full screen mode

Font Toolbar
The font toolbar only appears when there is an active text box.
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 Font type selector Center justify

Font size selector Right justify

Bolds font Subscript

Italicizes font Superscript

Underlines font Bullets

Left justify Text box type

Slides Tab
Displays thumbnails of all slides in the activity.

Media Tab
Allows you to search and use images in the Qwizdom database.

Templates Tab
Displays slide templates.
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Styles Tab
Displays slide styles.

4.1 Creating Slides

Information
Non-question slide.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select None as the slide type.
3. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
4. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.
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Multiple Choice
Multiple choice question slide (up to six choices). Use with Q2RF, Q4RF, and Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Multiple Choice as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Select the correct answer in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

Yes/No
Yes/No question slide. Use with Q2RF, Q4RF, and Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Yes/No as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Select the correct answer in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

True/False
True/False question slide. Use with Q2RF, Q4RF, and Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select True/False as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and
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using templates and styles are optional.
5. Select the correct answer in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

Numeric
Numeric question slide. Single digit numeric answer allowed for Q2RF; nine digit numeric
answer allowed for Q4RF; and eight digit numeric answer allowed for Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Numeric as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Enter the correct answer in the Answer field and press the Enter key on the

keyboard to save it.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

Sequence
Place item choices in the specified order. Use with Q4RF and Q5RF.

1. Click on the New  Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Sequence as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Enter the correct answer in the Answer field and press the Enter key on the

keyboard to save it.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.
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7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

Multiple Mark
This question type enables two or more correct answers (up to six choices). Use with Q4RF
and Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Multiple Mark as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Enter the correct answer(s) in the Answer field and press the Enter key on the

keyboard to save it.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

Rating Scale
Rating scale question slide (i.e. rating/opinions/polling using scales from 1-5, 1-10, etc.).
Use with Q4RF and Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Rating Scale as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Select the correct answer in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.
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Text Input (only applicable to Q5 RF remotes)
Answer can be up to 30 characters long.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Text Input as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Enter the correct answer in the Answer field and press the Enter key on the

keyboard to save it.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

Survey
Survey question slides do not have a correct answer. Use with Q2RF, Q4RF, and Q5RF.

1. Click on the  New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select None as the slide type.
3. Setting the time limit and number of points are optional.
4. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
5. Select "None" in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the 
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

 New Question button to create a new slide set.

4.2 MathML

1. Click on the  Equation button. MathML opens.
2. Enter an equation in the MathML window.
3. Click on the Close button (red X) when finished.
4. The equation will appear on the slide as an object.
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5. You can resize the equation by stretching the handles (click and drag).

4.3 Styles and Templates

Applying Styles
1. Create a slide with text.
2. Click on each text box and set the text box type (Heading, Body 1, Body 2, Answer

Choices).
3. Click on the Styles tab.
4. There are two ways to apply a style.

· Click and drag the style to the slide (on the right) to apply.
· Right-click on the style and select Apply to Slide, Apply to Question, or Apply to

Activity.
5. You are able to change the font style, size, and color after applying the style.

Applying Templates
1. There are two ways to apply a template.

· Click and drag the template onto the slide.
· Right-click on the template and select Load Template.

2. Once the template is on the slide, add text to create the slide.

4.4 Multimedia

Adding Images
There are two ways to add an image to a slide:

Using the Image Button

1. Click on the  Add Image button in the toolbar. The Open window appears.
2. Select the image and click on Open.
3. The image will appear on the slide.
4. Grab and drag the handles of the image to resize to desired size.

Using the Media Tab
1. Click on the Media tab.
2. Enter a word in the Keywords field to search for an image.
3. Images matching the keyword you entered will appear in the Media tab.
4. Select an image by dragging and dropping it onto the slide (on the right).

Adding Movies
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1. Click on the  Add Video button in the toolbar. The Open window appears.
2. Select the movie and click on Open.
3. The movie will appear on the slide.
4. Double-click the movie to play or stop it; or set the media properties.

Adding Sound

1. Click on the  Add Video button in the toolbar. The Open window appears.
2. Select the sound file and click on Open.
3. The sound file will appear on the slide.
4. Double-click the sound file to play or stop it; or set the media properties.

Multimedia Properties

· Visible in presentation-displays the movie and/or sound file with name on slide.
· Play when clicked-to play the movie or sound file when clicked with mouse.
· Show Controller-displays a box of the movie and/or sound file names with play and

stop buttons.
· Repeat-repeat movie or sound file continuously when the slide is displayed.
· Close when finished-to stop movie or sound file when finished.
· Play full screen-for movies, plays movie in full size; for sound, displays sound in

colors (best used with only the sound file on the slide).
· Play automatically-to play the movie or sound file upon slide display.
· Delay ---- seconds before playing-enter number of seconds for the movie or sound

file to play.

Setting Multimedia Properties
1. Right-click on the movie or sound file.
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2. Select Properties.
3. Select the options for presentation.
4. Click on OK to apply.

5 Qwizdom Actionpoint

Click on the  Qwizdom Actionpoint button in the floating toolbar to launch Qwizdom
Actionpoint. Microsoft PowerPoint will open displaying the Qwizdom Actionpoint toolbar.

5.1 Actionpoint Overview

From right to left:
Present (Actionpoint icon) button -presentation setup
Insert Slide-create a new slide
Question -displays slide type
Type-number of choices (applicable depending on question type)
Answer-correct answer or None for survey
Points-number of points awarded for correct response
Timer-allows slide to be viewed in presentation for time that is set
Configuration Settings button-remote setup
Participants button-create, modify, import participant lists
Reports button-upload saved presentation results to generate reports using

Microsoft Excel
About button-displays software version number

5.2 Slides

1. Click on the  Qwizdom Actionpoint button in the floating toolbar. Microsoft
PowerPoint will open.

2. Click on the  Insert Slide drop-down menu.
3. Select the type of slide you want to create.  The template will appear on the slide.
4. The Question field will indicate the slide format.
5. If you selected Multiple Choice, Sequence, Multiple Mark, or Rating Scale as the slide

format, the Type drop-down menu will show the number of choices you selected.  If
not, the Type field will be grayed out because it doesn't apply to the question type
you selected.

6. Type in the question and choices (if applicable).
7. After the question has been created, click on the Answer drop-down menu and
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select or type the correct answer.

If you type the answer into the Answer field, press the Enter key on the keyboard
to save it.

8. Click on the Points drop-down menu and select the point value or type in the
desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

9. Click on the Timer drop-down menu and select the time or type in the desired time
limit and press the Enter key on the keyboard to apply the time to the slide.

5.3 Participants

Creating a Participant List

1. Click on the  Participant button.  The Participant wizard will appear.
2. Select "Create New Participant List."
3. Enter a name for the class and click on Next.
4. In the Template Selection, select the template you would like to use (optional).

Remote ID is a default column within the templates.  You do not need to create a
field for the remote IDs, otherwise you will have two Remote ID columns.
Templates are commonly used fields to allow you to customize a participant list
you create or an existing one.  You can also use the predefined ones that are
available.

5. Select a template (optional) and click on Next.
6. Select the different fields you would like to use and click on Next.  If you do not see

a field you would like in the participant list, you can create a customized field and
add it to your template.
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7. If you want to create groups, enter the name of the group in the "Create a new
group" field and click on Add.  The name of the group will appear in the "Use the
following Groups" column.  Skip to the next step if you do not want to create
groups.

8. Click on Next.  The participant template will appear.
9. Fill in the fields and click on Finish.  The Save As window will open.
10. Click on Save and the participant list will save as a .QPL file.

Importing a .CSV (Comma Separated Values) File
You can import .CSV class and convert it into Qwizdom participant lists (.QPL).

If you have a class list in Microsoft Excel you would like to import, save them as
.CSV files.

1. Click on the  Participant button.  The Participant wizard will appear.
2. Select Import from a .CSV file.

3. Click on the  Browse button.  The Open window will appear.
4. Search for the .CSV file you want to import.
5. Select the .CSV file and click on Open.  The name of the class file will appear in the

Name field.
6. Click on Next.  You will be taken to Template Selection.
7. Select a template (optional) and click on Next.  If you are importing a class list from

Qwizdom Actionpoint, you will need to select a template and click on Next.  You will
be taken to the Import from CSV window.

When importing the participant's gender, the code for the gender should be
either M or True for male and F or False for females

8. Match the fields on the left to the fields on the right.  If you don't know what the
field is, select None.  Templates are commonly used fields to allow you to
customize a participant list you create or an existing one.  You can also use the
predefined ones that are available.

9. If the information on the left are headers, check the "First Record is Header" box,
otherwise leave it unchecked.  For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the "First Record is Header" box.  If the information on
the left show the actual name, remote number, etc., uncheck "First Record is
Header" because those are not headers.

10. Click on Next when all the fields have been matched.  You will be taken to Group
Selection.

11. If you want to create groups, enter the name of the group in the 'Create a new
group' field and click on Add.  The name of the group will appear in the "Use the
following Groups" column.  Skip to the next step if you do not want to create
groups.

12. Click on Next.  The class list will appear.
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13. Click on Finish and the Save As window will appear.
14. Type in the class name and click on Save.  The .CSV class will save as a .QPL file

(Qwizdom Participant List).
15. Click on Save.  The participant list will be available for you to select when you go

into presentation mode.

Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of
remotes set within the Configurations Settings window.  For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
of remotes, then not all remotes will register.

1. Open a PowerPoint presentation (that has been properly formatted with the
Qwizdom Actionpoint toolbar).

2. Click on the  Present button.  The Presentation Setup window will appear.
3. Click on the Participant List drop-down list and select Anonymous.
4. Enter in the number of participants.  The anonymous list has been created.

In Configuration Settings, check to make sure the estimated maximum number
of remotes reflects the number of the participants (or higher).  e.g If you have 32
participants but 24 as the estimated maximum number of remotes, then only 24
remotes will be allowed.

5. Click OK to begin presentation.

Editing an Existing Participant List

1. Click on the  Participant button.  The Participant wizard will appear.
2. Select "Browse and Modify Existing List."

3. Click on the  Browse button.  The Open window will appear.
4. Search for the participant list you want to edit.
5. Select it and click on Open.  The name of the participant list will appear in the

Name field.
6. Click on Next.  You will be taken to Participant Field Selection.  You may add new

fields or remove existing fields.  If you do not want to change anything, skip to the
next step.

7. Click on Next.  You will be taken to Group Selection. You may add new groups or
remove existing groups.  If you do not want to change anything, skip to the next
step.

8. Click on Next.  The participant list will appear.

You can renumber the remotes in order of any column you click on to order by
going to Options (in the Participant Wizard window) and selecting Autonumber
Remotes.

9. Make the necessary changes and click on Finish when done.  The Save As window
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will appear.
10. Enter the name of the class and click on Save.

5.4 RF Remote Setup

Follow the steps below to set up remotes.  Be sure the RF host* is properly installed before
proceeding.
v.86 host or higher is required for Qwizdom Actionpoint.  If the host is not v.857 host or higher, please contact
Technical Support to update your hardware.

· Estimated Maximum Number of Remotes-the number of remotes that will
be in use for presentation.  Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each
class/group.

· Enable Backlight-activates the back light on the Q5RF participant and
instructor remotes.

· Fixed Set-select this mode if you are K-12 or Corporate setting. Fixed Set is
where the remotes are assigned with an internal number (assigning fixed
numbers) where logging in by ID is mandatory.

· Roaming Set/Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a Session ID or Participant ID to join a
presentation.

1. Click on the  Configuration Settings button.  The Configuration Settings window
appears.

2. Enter an estimated number of remotes that will be used.
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3. Depending on the setting, select Fixed Set or Roaming Set/Participant Owned.
4. If not, click OK.

Session IDs
When using RF remotes for the first time, the remotes may ask for a session ID.  Session IDs
"assign" the remote to the host.  The remote identifies and communicates only with the
host the session ID is assigned to.  Each host has a default six digit session ID that is located
on the bottom of the host.

You can also create your own Session ID. The Session ID must be unique because if you
have other hosts in the same building, the remotes will become confused on which host
they should send the information to.  If you are using a fixed set, Session IDs only need to
be entered in once. If you switch hosts or use remotes from another set, you will need to
enter the session ID for the host you will be using into the remotes.

Assigning Fixed Numbers
If you have selected Fixed Set mode, then you would assigned fixed numbers to the
remotes if the participants will not be logging in by participant ID. Assigning fixed
numbers assigns the remote ID (e.g. remote #1, remote #2, etc.).  The file that contains the
remote assignments are saved onto the computer, not the actual remote.  You only have
to assign fixed numbers once unless you change computers or hosts.

1. Click on the  Configuration Settings button.  The Configuration Settings window
appears.

2. Select Fixed Set.
3. Click on the Assign button.  The Remote Assignment window will appear.
4. Click on the Host drop-down menu and select the COM number (of the host) you

will be using.
5. Enter in the session ID in the Session ID field or use the default ID.
6. Click on the Start button.
7. Turn on the remotes and enter the session ID.  When the remotes communicate

with the host, the number of the remote (with a remote image) will appear in the
window.  The remote number will also appear on the remote.

8.       After all the remotes have been assigned, click on Stop.
9. If you are not using multiple hosts, skip to step 15.  If you are using multiple hosts,

continue to step 10.
10. Click on the Host drop-down menu and select the COM number of the other host

you will be using.
11. Enter in the session ID in the Session ID field.
12. Click on the Start button.
13. Turn on the remotes and enter the session ID.  The remotes will be assigned to this

host only.
14. When the remotes have been assigned fixed numbers, click on the Stop button.
15. Click OK to save and exit the Remote Assignment window.
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16. Click OK to save and exit the Configuration Settings window.

Changing Session IDs
If the RF remote says "No Net," "Not Found," "Not Active," or "Inactive," it could be that the
session ID is not correct.

· For Q2RF remotes-wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see "--S" on the display, it is prompting you
for the session ID. Enter it and press the Send key to confirm.

· For Q4RF remotes-press the Menu key, use the right arrow to scroll to Sess. ID., and
press the Send (double arrows) key to select the option.  You will see the current
session ID and will be asked if you want to change the session ID.  Press T (Yes) to
change.  Enter the session ID and press the Send (double arrows) key to send.

· For Q5RF remotes-wait for the remote to say "No Net," "Not Active," or "Not Found."
Press the Menu key and select Enter Session ID using the Send (double arrows) key or
the circle key on the thumb pad.  Enter the session ID and press the Send (double
arrows) key.

Logging in with Participant IDs
Participant IDs can only be numeric.

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Click on the Login tab.
3. Select "Require Login by ID."
4. Select the participant list and any other options you want to apply to the

presentation.
5. Click OK to begin the presentation.
6. The remotes will display "User ID."
7. Enter the participant ID and press the Send (double arrows) key.
8. If a remote says "Access Denied" or "Denied," then the participant ID may have been

entered incorrectly.
· For Q2RF, when you see "--U," enter the participant ID and press Send.
· For Q4RF remotes, press the Menu key, use the right arrow to scroll to User ID,

and press the Send (double arrows) key to select it.  Re-enter the participant
ID and press the Send (double arrows) key.

· For Q5RF remotes, press the C (clear) key, re-enter the participant ID, and
press the Send (double arrows) key.

The participant IDs will be remembered for the session until another participant list is
selected to present to.

Using Multiple Hosts
Up to 16 hosts (with 1000 remotes on each) can be used for presentation for Q4RF and
Q5RF.
If you have selected to use fixed set, be sure you have assigned fixed numbers for the
remotes using all RF hosts.
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1. Click on the  Present button.  The Presentation Setup window will appear.
2. Click on the Login tab.
3. Select the hosts you will be using by placing a check mark in each one of the

boxes.
4. You can create your own session ID in the User Session column or use the default

session ID.

If you use the default session ID in the  Host Session column, the User Session
column must be blank.

5. Click on OK to begin the presentation.
6. When the presentation appears, turn on the remotes.
7. If you assigned fixed numbers, the remotes will automatically log into the correct

host, using the session IDs used at that time.
8. Enter the appropriate session IDs into the remotes (including instructor) if

prompted to do so and press the Send (double arrows) key.  Press the C (clear) key
to delete if you accidentally mistyped a number or see Changing Session IDs
above for more information.

9. At this time, the remote should display the question answer choices or it may
display "Qwizdom" and the remote number.

10.    Below are other things the remotes may display:
· The instructor remote will say "Ready" or "Last Key."
· If the Q4RF/Q5RF remotes say "Qwizdom" and display their remote number,

they are ready and waiting for a question slide to appear.  Remotes can only
respond when the slides are remote-answerable such as Multiple Choice,
True/False, Numeric, etc.

· The LCD screen on the Q4RF/Q5RF remotes may read "Push Key," "Inactive," or
"Not Active,"  press the Send (double arrows) key to "wake up" the remote.

· If the Q4RF displays "No Net" or Q5RF displays "Host not found," re-enter the
session ID.

· If the Q4RF displays "Denied" or Q5RF displays "Access Denied," this could be
that the participant/user ID is incorrect, or the remote number attempting to
participate isn't in the participant list that was loaded.  Re-enter the
participant/user ID, and check to make sure that remote number is in the
participant list.

· If the Q2RF displays "- - -," the remote could not find an active host and will
automatically turn off. Turn remote back on and press the Help key to enter
the correct session ID.

If the remotes continue say "No Net" and will not establish a connection to the host, go to
Initializing the Host to get the host to initialize.  If you need further help, please contact
Technical Support.
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5.5 Presentation

Before presenting a PowerPoint presentation using Qwizdom remotes, please see
Presentation Setup to learn about the presentation features.

1. Click on the  Present button.
2. The Presentation Setup window appears.
3. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
4. Click on the Saved Results drop-down field and select how you would like to save

the results.
5. Select the options you would like available during presentation in the General,

Login, Display and Chart tabs in the lower part of the Presentation Setup window.
6. Click on OK to begin the presentation.

If you present using the PowerPoint Slide Show options, Qwizdom remotes will
not activate.  You must present the slides by clicking on the  Present button to use
Qwizdom remotes.

7. Have the participants turn on their remotes.
8. Either the answer choices or a blank screen appears on the remote, depending on

the question type.
Here are a few things you may execute during presentation:

· Display the response chart by pressing the / key
· Display the private graph by pressing the zero key
· Randomly call upon a participant by pressing the Pick key
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9. Go through the presentation until all the question slides are answered.
10. When you are unable to advance to the next slide, this means the presentation is

done.  Press the circle key in the thumb pad to stop the presentation (screen will go
black) and press it again to exit back to PowerPoint.

5.5.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be
applicable.

General tab:
Send Right/Wrong Feedback to Remotes after answering-remotes will receive a check
mark if answer is correct and an X if answer is incorrect. Remotes will receive both a
check mark and X if feedback is turned off to indicate that the response has been
received.
Allow participants to change answer-checking this option allows participants to
change their answer for the question slide they are on.
Override Points Value with Global Point value of "----" points-enter the new amount
of points that will be applied to the slide temporarily for that presentation.
Timer-you can select no timer, use the time set within the slides, and global timer by
entering the number of seconds for all slides in the presentation.

Login tab:
Require Login by ID-checking this option will have remotes prompt participants to
enter their participant ID.
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Show Login Screen-displays the login screen so the instructor can view the participants
that are logging in.
Add & Allow Unregistered participants-participants will be added to the participant by
logging in with their participant ID. This option must be checked when using an
Anonymous list. For the Anonymous list, participants will only log in with the session ID.
Deny Login After "----" minutes-logins after the set amount of time will not be
accepted.

Display tab:
Show function toolbar (not needed if using Presenter Remote)-checking this option
will display toolbar with Response Chart, Pick, and Re-pose buttons.
Display Response Indicator-this displays the percentage of the class that has
answered; double-click the percentage to convert to a fraction.
Show 'Start/Stop' responding to questions indicator-clicking on Stop will pause the
presentation and responses will not be accepted. Clicking on Start reposes the
question.

Chart tab:
Automatically Show Correct Answer on Chart-checking this option will display toolbar
with Response Chart, Pick, and Re-pose buttons.
Background Filename-selecting this option will allow you to select an image to display
as the response chart background.
Select Graph Layout-select how the response chart will be displayed during
presentation.

Advanced Settings
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Advanced Settings
· Allow Instructor to go back to a previous slide-checking this option allows the

instructor remote to move back to a previous slide.
· Reset Com-Port When Starting Presentation-this option is checked by default to

ensure the host activates when presentation begins.
· Ask for confirmation of User ID when not on list-the remote will prompt the

participant for the user ID again, if the participant is not in the participant list that is
loaded.

Advanced Hardware Settings
· Don't require "Send" on single key answers-the remote will automatically send the

answer once it has been entered.
· Disable "Change UserID" menu during Login-hides the "User ID" option from the

menu.
· Disable "Change SessionID" menu during Login-hides the "Session ID" option from

the menu.
· Disable "Change UserID" menu during active Session-hides the "User ID" option

from the menu during presentation.
· Disable "Change SessionID" menu during active Session-hides the "Session ID"

option from the menu during presentation.
· Do not show what key was pressed on Q2's-does not show the key that is pressed

on the display.
· Turn off remotes on presentation end-automatically turns off the Q2RF and Q4RF

remotes when a presentation ends.

5.5.1.1 Presentation Settings

Presentation settings can be saved and loaded (onto the same computer or another
computer) into the Presentation Setup window of Actionpoint, Answer Key, and Question Bar
applications.
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Saving Presentation Settings
1. In the Presentation Setup window, select the options you would like during

presentation.
2. Go to the File menu and select Save Settings. The Save As window appears.
3. Enter the name for the selected settings.
4. Click on Save. The settings will save as a .CFG file in the location you selected.

Loading Presentation Settings
1. In the Presentation Setup window, go to the File menu.
2. Select Load Presentation Settings. The Open window appears.
3. Select the saved settings file (.CFG) and click on Open.
4. The current settings in the Presentation Setup window will change to the settings

you selected to load.

5.5.1.2 Saving Results

All results are saved as an .QRX file but can be converted into a .CSV (Comma Separated
Values) file.

Manual Save
1. Click on the  Present button.  The Presentation Setup window will appear.
2. Select Browse for Save Location.
3. Click on the  Browse button. The Save As window appears.
4. Select a location to save the results in.
5. Enter the name you want the results to be saved as.
6. Click on Save.  The file name and location will appear in the Save Results field.
7. The results will save in the selected location.

Auto-save
1. Click on the  Present button.  The Presentation Setup window will appear.
2. Select Auto Save as 'Filename + List + Date.'
3. The Browse for Folder window appears.
4. Select the location and click on OK.
5. The file name will contain the location, name of the participant list, date, and time

under the Save Results field.
6. The results will save when the presentation is complete.

Auto-Save to Results Manager
You must be logged into Qwizdom Online to access this feature.

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Select Auto Save to Results Manager.
3. The results will save in the Results/Reports window when the presentation is
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complete.

5.5.1.3 Remote Login

Logging in with IDs allows participants to use any remote.  If you use participant IDs from a
participant list, the ID will link the remote to the participant's information in the list.

To have participants log in, they must have a participant ID.  Participant IDs are setup when
creating participant lists.  (Go to Participant Lists for more information).  Each participant
should have a unique ID assigned to their name.

· Participant IDs can only be numeric.
· The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
· The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
· IDs cannot be used for more than one participant (IDs cannot be duplicated).

1. Open a PowerPoint presentation or create one to present.
2. Click on the  Present button.  The Presentation Setup window will appear.
3. Select a participant list from the "Participant List" drop-down menu.
4. Click on the Login tab.
5. Check the "Require Login by ID" option.
6. Checking the "Show Login Screen" is optional.
7. Select all other preferred options and click on OK to present.  The presentation will

begin.
8. The remotes will display "User ID."
9. Participants will enter their ID and press the Send (double arrows) key.
10. Once everyone has logged in, begin the presentation.

You can start the presentation as participants log in. Participants who are late, can log in
later if you have not set a timer to deny log-in.

Login Timer
You can deny login after a certain amount of time by setting the time under the Login tab.

1. Check the "Deny Login After ---- Minutes" option.
2. Enter the number of minutes that participants have to log in.

For example, you have select to deny log in after 5 minutes. After 5 minutes has passed,
participants who try to log in will be denied.
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5.5.1.4 Presentation Queue

Presentation queues are only for Actionpoint using PowerPoint presentations.

Use Presentation Queue
1. Click on the Present button. The Presentation Setup window appears.
2. Go to the File menu and select Use Presentation Queue. The Presentation Queue

window appears.
3. Click on Add. The window will change to show three fields: Presentation, Participant

List, and Results.
4. Click on the Browse button for Presentation. The Open window appears.
5. Select the presentation and click on Open.
6. Click on the Browse button for Participant List. The Open window appears.
7. Select the participant list and click on Open.
8. Click on the Browse button for Results. The Save As window appears.
9. Select a location where the results will be saved.
10. Enter a name for the results and click on Save.
11. Click on Add.  You will be taken back to the Presentation Queue window and see the

files you just added.
12. Repeat steps 4-12 to add another presentation.
13. When you are finished creating your queue, click on Save Queue. The Save As

window appears.
14. Select a location where you would like to save the queue.
15. Enter a name for the queue and click on Save.
16. Click on OK. You will be taken back to the Presentation Setup window.
17. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
18. Click on the Saved Results drop-down field and select how you would like to save

the results.
19. Select the options you would like available during presentation in the General,

Login, and Display tabs in the lower part of the Presentation Setup window.
20. Click on OK and the queue will start.
21. When the first presentation is complete, exit presentation mode.
22. The results will save as a .QRX file in the selected location with a designated name.
23. The second presentation will begin, on its own, in a few moments.

This process will repeat depending on how many presentations are set in the queue.
Results will be generated after each presentation is closed upon completion.

Loading a Saved Presentation Queue
1. Double-click on the Actionpoint icon.
2. Click on the Present button. The Presentation Setup window appears.
3. Go to the File menu and select Use Presentation Queue. The Presentation Queue

window appears.
4. Click on Load Queue. The Open window appears.
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5. Select the queue you want to use and click on Open. The files will appear in the
Presentation Queue window.

6. Click on OK and you will be taken back to the Presentation Setup window.

5.5.2 Presentation Features

Function Bar
The control bar has the Response Graph, Pick, and Re-Pose buttons.  To view the control bar
during presentation, select "Show Function Bar" in Display tab.

Response Graph

1. Click on the  Response Graph button.
2. The Response Graph appears.
3. Click on the available chart(s) to view the results.
4. Double-click on the title bar of the window to display the graph in full screen.

Picking Participants

1. Click on the  Pick button to randomly call up on a participant.
2.  The participant's name will appear on screen.

3. Click on the  Pick button again to remove the name.

Re-posing a Question
Re-posing is used to ask a question again and/or  when you accidentally skip a slide that
needs to be answered. Re-posing the question overwrites the previous responses if any are
recorded.

1. Click on the  Re-pose button to ask the question on the slide again.

Response Indicator

The response indicator displays the percentage of participants that have answered.
In the Presentation Setup window:

1. Check the "Display Response Indicator" box in the Display tab.
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2. In presentation mode, you can move the response indicator by clicking on it with
the mouse and dragging it to another area of the screen.

3. To change the indicator view, double-click on it to display responses as fractions.
4. Double-click again to change indicator back to percentage.

Start/Stop Indicator

The start/stop indicator resets the time and reposes the question.
1. Check the "Show 'Start/Stop responding to questions indicator" box in the Display tab

of the Presentation Setup window.

Timer
To view the timer during presentation, click on the Timer drop-down list in the General tab
to view the timer options.  Here are a few tips on using the timer:

· The timer has pause/play, stop, and add/subtract 5 seconds options.
· You can move the timer by clicking on it and dragging it to another area of the

screen.
· Remotes will not be able to answer when time is up.

You can set the timer two ways; use the time from each slide or apply a new time to the
presentation.  When you create a slide, you enter the amount of time you want the slide to
display for.
To set a new time to the presentation:

1. Click on the Timer drop-down list and select "Use Global Timer Value of..."
2. Enter the number of seconds.
3. Click on OK to present the presentation with the newly set time.

Points
You can set the point value two ways; use the point value from each slide or apply a new
point value to all the questions in the presentation.  When you create a slide, you enter the
number of points the correct response will be awarded.  Go to Creating a Slide for more
information.
To apply a new point value to all the questions in the presentation:

1. Check the "Override Point Value with Global Point value of ---- points" option.
2. Enter the number of points.
3. Click on OK to present the presentation with the newly set time.

Right/Wrong Feedback
This allows participants to see if their response is right or wrong.

1. Check the "Send Right/Wrong Feedback to Remotes after answering" box in the General
tab of the Presentation Setup window.

Feedback will appear on the LCD screen of the participant's remote during presentation.  A
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check mark will indicate a correct response, an X will indicate an incorrect response. If the
feedback is disabled, a check mark and X will appear on the LCD screen indicating that a
response was received.

5.5.2.1 Response Graph

During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
graph.

Public Response Graph
1. Press the / key on the RF instructor remote.
2. The response graph will appear on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the / key again to remove the response graph.

If you have a graph displayed, either on the instructor remote or computer, you
must first remove that graph before displaying the other graph and/or move onto
the next question.

Bar Chart

Press circle key to show bars horizontally or vertically.
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Pie Chart Displaying Correct Answer with Number of Responses

Pie Chart Displaying Correct Answer with Percentages

Pie Chart Displaying Number of Responses
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Pie Chart Displaying Number of Responses

List View Chart
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Scores Chart

Private Response Graph
1. Press the 0 key on the RF instructor remote.
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2. A bar chart showing the number of responses will display on the RF instructor
remote's LCD screen.

3. Press the 0 key again to remove the graph.

5.6 Reports

You can generate reports* using existing saved results.
*Registered  version of Microsoft Excel is required to generate reports.

1. Click on the  Reports button.  The Reporting Wizard window will appear.
2. Click on the Browse button to search for the file you want to generate a report for.

The Open window will appear.
3. The file type will be .QRX.  Search for the file and select it.
4. Click on Open.
5. Select the type of report you want to generate and click OK.  Microsoft Excel will

open to generate the report.
6. In Microsoft Excel, go to the File menu and select Save to save the report.

Report Features
Excel Reports:

· Answer Report-displays bar chart and lists participant names, ID, and remote ID with
score and breakdown of responses for each question.

· Answer Distribution Report-shows a percentage for each answer choice, correct
answer, percentage of correct answers , and the average of the answer sent for each
question.

· Score Report-displays bar chart and shows the participant information with the
number of correct responses out of the total number of questions answered and in
the presentation. Also, shows score and spontaneous question totals.
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· Attendance Report-displays participant information with their remote login time,
number of questions answered and total questions.

· Participant Detail Report-displays detailed participant information such as name,
ID, and group number.

Export:
· Convert to .CSV-selecting this options converts the .QRX file into a .CSV.

Options:
· Override the Point value of all slides to be "----" points-overrides point value that

was awarded during presentation.

6 Answer Key

Click on the  Answer Key button in the floating toolbar. The Answer Key Maker
window appears.

Creating an Answer Key

1. Click on the  New Answer Key button.

2. Click on the  Insert a Question button.
3. Select the question type and answer.
4. Set the number of points.

5. Click on the  Insert a Question button and repeat steps 2-4.

If you delete a question or if the numbering is not in sequential order, go to the
Tools menu to select Renumber Questions to correct.

6. When the answer key is complete, click on the  Save button. The Save As
window will appear.

7. Select the location the answer key will be saved and enter a name.
8. Click on Save when done. The answer key will save as a .QAK file.

Presenting an Answer Key

1. Click on the  Open button. The Open window appears.
2. Select the answer key you want to present and click on Open.
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3. The answer key will appear.

4. Click on the  Present button.
5. The Presentation Setup window appears.
6. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
7. Click on the Saved Results drop-down field and select how you would like to save

the results.
8. Select the options you would like available during presentation in the General,

Login, and Display tabs in the lower part of the Presentation Setup window.
9. Click on OK to begin the presentation.
10. The Privacy Screen appears.

Click on the little red X, below the blue bar that shows the word Activity, to
show a grid of all the participants. You can view their progress and scores
during the answer key.

11. The answer key will load into the remote.
12. When the answer key is complete, click on the large red X in the top left corner of

the Paper-Based Score Entry window.
13. You will be taken back to the Answer Key Maker window.
14. The saved results will save in the location you selected.

Presenting Odd-Numbered Questions

1. Click on the  Open button. The Open window appears.
2. Select the answer key you want to present and click on Open.
3. The answer key will appear.
4. Go to the Edit menu and select "Select Odd." Only the odd-numbered questions will

be checked.

5. Click on the  Present button.
6. Participants will only answer the odd-numbered questions during their answer

key.

Presenting Even-Numbered Questions

1. Click on the  Open button. The Open window appears.
2. Select the answer key you want to present and click on Open.
3. The answer key will appear.
4. Go to the Edit menu and select "Select Even." Only the even-numbered questions

will be checked.

5. Click on the  Present button.
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6. Participants will only answer the even-numbered questions during their answer
key.

Presenting Selected Question Numbers

1. Click on the  Open button. The Open window appears.
2. Select the answer key you want to present and click on Open.
3. The answer key will appear.
4. Check the question numbers you want to present.

5. Click on the  Present button.
6. Participants will only answer the selected question numbers during their answer

key.

Presenting Multiple Answer Keys

1. Click on the  Open button. The Open window appears.
2. Select an answer key and click on Open.
3. The answer key will open with the Test Number (Activity ID) in the title bar of the

window.
4. Write down the test number (activity ID).
5. Open another answer key and do the same.
6. Click on the black arrow to the right of the Present button.
7. Select Present Multiple Answer Keys.
8. The Browse for Folder window appears.
9. Select the location of the answer keys. With multiple answer keys, they must be

saved in the same location (i.e. Desktop, My Documents, etc.).
10. Click on OK and the Presentation Setup window will appear.
11. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
12. Click on the Saved Results drop-down field and select how you would like to save

the results.
13. Select the options you would like available during presentation in the General,

Login, and Display tabs in the lower part of the Presentation Setup window.
14. Click on OK to begin the presentation.
15. The Privacy Screen appears.

Click on the little red X, below the blue bar that shows the word Activity, to
show a grid of all the participants. You can view their progress and scores
during the answer key.

16. Activity ID will appear on the remote LCD screen.
17. Enter the test number (activity ID) of the answer key into the remote and press the

Send key.



Qwizdom Actionpoint User Guide55

Qwizdom Actionpoint 2007

18. The answer key will load into the remote.
19. When all answer keys have been completed, click on the large red X in the top left

corner of the Paper-Based Score Entry window.
20. You will be taken back to the Answer Key Maker window.
21. The saved results will save in the location you selected.

Generating a Report for an Answer Key
1. Go to the Tools menu and select Reporting. The Reporting Wizard window appears.
2. Click on the Browse button. The Open window appears.
3. Search for the saved results and select it.
4. Click on Open.
5. Select a report type.
6. Click on the Generate button.
7. Microsoft Excel  will open displaying the saved results in report form.

7 Question Bar

Question Bar (without Instructor Remote)

1. Click on the  Question Bar button in the floating toolbar. The Presentation
Setup window appears.

2. Click on the Participant List drop-down field and select what type of participant list
you would like to use.

3. Click on the Saved Results drop-down field and select how you would like to save
the results.

4. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window.

5. Click on OK to begin the presentation.
6. The Question Bar will appear at the top of the screen.
7. Click on New.
8. Select the question type from the Type drop-down list.
9. Select an answer at this time; or you can select the correct answer when the

question has stopped.
10. Click on Pose.
11. Participants will send their responses.

The response graph can be displaying during and after the posed question by
pressing the / (graph) key on the instructor remote.
12. When time is up or when the question has been answered, click on Stop.
13. If you chose to select a correct answer after the question has been posed, select

the correct answer now; otherwise, click on New to pose a new question.
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14. Repeat steps 9 through 14 until the presentation is complete.
15. Click on the Utilities button and select Exit.
16. The saved results will generate in the location that was designated.

A report for the saved results can be generated within the Results/Reports
window of Qwizdom Connect.

Question Bar (with Instructor Remote)

1. Click on the  Question Bar button in the floating toolbar. The Presentation
Setup window appears.

2. The Presentation Setup window appears.
3. Click on the Participant List drop-down field and select what type of participant list

you would like to use.
4. Click on the Saved Results drop-down field and select how you would like to save

the results.
5. Select the options you would like available during presentation in the General,

Login, and Display tabs in the lower part of the Presentation Setup window.
6. Click on OK to begin the presentation.
7.  The Question Bar will appear at the top of the screen.
8. Press the New Q button on the instructor remote. A list of question types will

appear on the LCD.
9. Use the arrows on the thumb pad to scroll through the different question types.
10. Press the Send or Circle key (in thumb pad) to select the question type.
11. You can select the correct answer and press Send; or press Send without selecting a

correct answer (survey).
12. Participants will send their responses.

The response graph can be displaying during and after the posed question by
pressing the / (graph) key on the instructor remote.
13. When time is up or when the question has been answered, press the New Q button

again to pose another question.
14. Repeat steps 8-11 until the presentation is complete.
15. Click on the Utilities button and select Exit.
16. The saved results will generate in the location that was designated.
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8 Users/Participants

Creating a Participant List

1. Click on the  Users/Participants button in the floating toolbar. The
Users/Participants window opens.

2. Click on the  Participant Wizard button.  The Participant wizard will appear.
3. Select "Create New Participant List."
4. Enter a name for the class and click on Next.
5. In the Template Selection, select the template you would like to use (optional).

Remote ID is a default column within the templates.  You do not need to create a
field for the remote IDs, otherwise you will have two Remote ID columns.
Templates are commonly used fields to allow you to customize a participant list
you create or an existing one.

6. Select a template (optional) and click on Next.
7. Select the different fields you would like to use and click on Next.  If you do not see

a field you would like in the participant list, you can create a customized field and
add it to your template.

8. If you want to create groups, enter the name of the group in the "Create a new
group" field and click on Add.  The name of the group will appear in the "Use the
following Groups" column.  Skip to the next step if you do not want to create
groups.

9. Click on Next.  The participant template will appear.
10. Fill in the fields and click on Finish.  The Save As window will open.
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11. Click on Save and the participant list will save as a .QPL file.

Importing a .CSV (Comma Separated Values) File
You can import .CSV class and convert it into Qwizdom participant lists (.QPL).

If you have a class list in Microsoft Excel you would like to import, save them as
.CSV files.

1. Click on the  Users/Participants button in the floating toolbar. The
Users/Participants window opens.

2. Click on the  Participant Wizard button.  The Participant wizard will appear.
3. Select Import from a .CSV file.

4. Click on the  Browse button.  The Open window will appear.
5. Search for the .CSV file you want to import.
6. Select the .CSV file and click on Open.  The name of the class file will appear in the

Name field.
7. Click on Next.  You will be taken to Template Selection.
8. Select a template (optional) and click on Next.

When importing the participant's gender, the code for the gender should be
either M or True for male and F or False for females

9. Match the fields on the left to the fields on the right.  If you don't know what the
field is, select None.  Templates are commonly used fields to allow you to
customize a participant list you create or an existing one.  You can also use the
predefined ones that are available.

10. If the information on the left are headers, check the "First Record is Header" box,
otherwise leave it unchecked.  For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the "First Record is Header" box.  If the information on
the left show the actual name, remote number, etc., uncheck "First Record is
Header" because those are not headers.

11. Click on Next when all the fields have been matched.  You will be taken to Group
Selection.

12. If you want to create groups, enter the name of the group in the 'Create a new
group' field and click on Add.  The name of the group will appear in the "Use the
following Groups" column.  Skip to the next step if you do not want to create
groups.

13. Click on Next.  The class list will appear.
14. Click on Finish and the Save As window will appear.
15. Type in the class name and click on Save.  The .CSV class will save as a .QPL file

(Qwizdom Participant List).
16. Click on Save.  The participant list will be available for you to select when you go
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into presentation mode.

Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of
remotes set within the Configurations Settings window.  For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
of remotes, then not all remotes will register.

1. Select an activity, answer key, etc. to present.

2. Click on the  Present button.  The Presentation Setup window will appear.
3. Click on the Participant List drop-down list and select Anonymous.
4. Enter in the number of participants.  The anonymous list has been created.

In Configuration Settings, check to make sure the estimated maximum number
of remotes reflects the number of the participants (or higher).  e.g If you have 32
participants but 24 as the estimated maximum number of remotes, then only 24
remotes will be allowed.

5. Click OK to begin presentation.

Editing an Existing Participant List

1. Click on the  Users/Participants button in the floating toolbar. The
Users/Participants window opens.

2. Click on the  Participant Wizard button.  The Participant wizard will appear.
3. Select "Browse and Modify Existing List."

4. Click on the  Browse button.  The Open window will appear.
5. Search for the participant list you want to edit.
6. Select it and click on Open.  The name of the participant list will appear in the

Name field.
7. Click on Next.  You will be taken to Participant Field Selection.  You may add new

fields or remove existing fields.  If you do not want to change anything, skip to the
next step.

8. Click on Next.  You will be taken to Group Selection. You may add new groups or
remove existing groups.  If you do not want to change anything, skip to the next
step.

9. Click on Next.  The participant list will appear.

You can renumber the remotes in order of any column you click on to order by
going to Options (in the Participant Wizard window) and selecting Autonumber
Remotes.

10. Make the necessary changes and click on Finish when done.  The Save As window
will appear.
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11. Enter the name of the class and click on Save.

8.1 Groups

Groups are necessary for certain games.
Creating Groups

1. Select the class, in the Class drop-down menu, you want to create groups for.

2. Click on the  Groups button.  The Group Management window will open.
3. In the Automatic Grouping Options tab, select the Grouping Action.

· Balance-groups students by ability
· Group Similar-groups students evenly; one team may be odd depending on

the number of students in your class
· Random-groups students randomly; groups may be odd/even
· Group Size-specify the number of students in each group
Assign Members Based On-you are able to assign partners based on ability and
performance
· Activity Score-based on overall grade on a particular activity
Select an Activity-use this drop-down menu to select the activity when you are
assigning partners based on selected activity performance.
· Predefined Ability Rating-based on participants capability of learning

4. Under Grouping Action, select Balance.
5. Select Overall Performance under Assign Members Based On.
6. Click on Generate and then click on Done when finished.

You can click on students to drag and drop them into different groups.

8.2 Seating

The seating chart is used to track student seating and needs to be completed to take
attendance.  See Attendance for more information.

1. Select the class you want to setup the seating chart for.

2. Click on the  Seating Chart button to bring up the seating chart. The Seating
Chart window appears.

3. Student names will be in a column on the right.
4. Click and drag the name of a student to place them onto the seating chart.
5. Click on OK when you are finished.
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8.3 Attendance

The seating chart must be completed before you start taking attendance. See Seating
Chart for more information.

1. Select the class you want to take attendance for.

2. Click on the  Attendance button. The Attendance window will appear.
3. Click on the Layout or List tab.
4. Mark the attendance of each student by clicking on the student name.
5. Click on OK when finished.

Attendance by Remote Login
1. Select the class you want to take attendance in.

2. Click on the  Attendance button. The Attendance window will appear.
3. Click on the Layout or List tab.
4. Click on the Host drop-down list and select the COM number the host is on. The

session ID will automatically appear in the SessionID field.
5. Using the RF remotes to log in, press the Menu key.
6. Select Login and press the Send (double arrows) key.
7. The students would enter their ID and press the Send (double arrows) key.
8. Click on OK when finished.

9 Results/Reports

You can generate reports* using existing saved results.
*Registered  version of Microsoft Excel is required to generate reports.
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1. Click on the  Reports/Results button in the floating toolbar. The
Reports/Results window appears.

2. Click on the  Report Wizard button.  The Reporting Wizard window will appear.
3. Click on the Browse button to search for the file you want to generate a report for.

The Open window will appear.
4. The file type will be .QRX.  Search for the file and select it.
5. Click on Open.
6. Select the type of report you want to generate and click OK.  Microsoft Excel will

open to generate the report.
7. In Microsoft Excel, go to the File menu and select Save to save the report.

Report Features
Excel Reports:

· Answer Report-displays bar chart and lists participant names, ID, and remote ID with
score and breakdown of responses for each question.

· Answer Distribution Report-shows a percentage for each answer choice, correct
answer, percentage of correct answers , and the average of the answer sent for each
question.

· Score Report-displays bar chart and shows the participant information with the
number of correct responses out of the total number of questions answered and in
the presentation. Also, shows score and spontaneous question totals.

· Attendance Report-displays participant information with their remote login time,
number of questions answered and total questions.

· Participant Detail Report-displays detailed participant information such as name,
ID, and group number.
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Export:
· Convert to .CSV-selecting this options converts the .QRX file into a .CSV.

Options:
· Override the Point value of all slides to be "----" points-overrides point value that

was awarded during presentation.

10 Settings/Preferences

Click on the  Settings/Preferences button in the floating toolbar. The Preferences
window appears.

General Tab
· Auto-start Qwizdom Connect on system start up-checking this option will open

Qwizdom Connect when you're computer starts up.
· Show toolbar on desktop during startup-displays Qwizdom Connect toolbar when

program is launched.
· Auto-login to Qwizdom Connect-automatically logs in with your username and

password when Qwizdom Connect is opened. When this option is checked, you will
be prompted to enter your username and password to store for the auto-login
process.

· Auto-upload results to Qwizdom Connect-must be logged in for feature to enable
results to be automatically uploaded to the Results/Reports window of Qwizdom
Connect.

· Toolbar Items-icons that are checked will appear in the toolbar, icons that are
deselected will be removed (hidden) from the toolbar.

· Remote Settings-See Remote Setup for more information.
· Start Registration Wizard-Qwizdom Connect registration.

Standards Tab
1. Select your state standards in the Select State drop-down list.
2. Click on Download State Standards to download your state standards into Qwizdom

Connect.

11 Remote Setup

Follow the steps below to set up remotes.  Be sure the RF host* is properly installed before
proceeding.
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v.86 host or higher is required for Qwizdom Actionpoint.  If the host is not v.86 host or higher, please contact
Technical Support to update your hardware.

· Estimated Maximum Number of Remotes-the number of remotes that will
be in use for presentation.  Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each
class/group.

· Enable Backlight-activates the back light on the Q5RF participant and
instructor remotes.

· Fixed Set-select this mode if you are K-12 or Corporate setting. Fixed Set is
where the remotes are assigned with an internal number (assigning fixed
numbers) where logging in by ID is mandatory.

· Roaming Set or Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a Session ID or Participant ID to join a
presentation.

1. Click on the  Configuration Settings button.  The Configuration Settings window
appears.

2. Enter an estimated number of remotes that will be used.
3. Depending on the setting, select Fixed Set or Roaming Set/Participant Owned.
4. If not, click OK.

Session IDs
When using RF remotes for the first time, the remotes may ask for a session ID.  Session IDs
"assign" the remote to the host.  The remote identifies and communicates only with the
host the session ID is assigned to.  Each host has a default six digit session ID that is located
on the bottom of the host.
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You can also create your own Session ID. The Session ID must be unique because if you
have other hosts in the same building, the remotes will become confused on which host
they should send the information to.  If you are using a fixed set, Session IDs only need to
be entered in once. If you switch hosts or use remotes from another set, you will need to
enter the session ID for the host you will be using into the remotes.

Assigning Fixed Numbers
If you have selected Fixed Set mode, then you would assigned fixed numbers to the
remotes if the participants will not be logging in by participant ID. Assigning fixed
numbers assigns the remote ID (e.g. remote #1, remote #2, etc.).  The file that contains the
remote assignments are saved onto the computer, not the actual remote.  You only have
to assign fixed numbers once unless you change computers or hosts.

1. Click on the  Configuration Settings button.  The Configuration Settings window
appears.

2. Select Fixed Set.
3. Click on the Assign button.  The Remote Assignment window will appear.
4. Click on the Host drop-down menu and select the COM number (of the host) you

will be using.
5. Enter in the session ID in the Session ID field or use the default ID.
6. Click on the Start button.
7. Turn on the remotes and enter the session ID.  When the remotes communicate

with the host, the number of the remote (with a remote image) will appear in the
window.  The remote number will also appear on the remote.

8.       After all the remotes have been assigned, click on Stop.
9. If you are not using multiple hosts, skip to step 15.  If you are using multiple hosts,

continue to step 10.
10. Click on the Host drop-down menu and select the COM number of the other host

you will be using.
11. Enter in the session ID in the Session ID field.
12. Click on the Start button.
13. Turn on the remotes and enter the session ID.  The remotes will be assigned to this

host only.
14. When the remotes have been assigned fixed numbers, click on the Stop button.
15. Click OK to save and exit the Remote Assignment window.
16. Click OK to save and exit the Configuration Settings window.

Changing Session IDs
If the RF remote says "No Net," "Not Found," "Not Active," or "Inactive," it could be that the
session ID is not correct.

· For Q2RF remotes-wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see "--S" on the display, it is prompting you
for the session ID. Enter it and press the Send key to confirm.

· For Q4RF remotes-press the Menu key, use the right arrow to scroll to Sess. ID., and
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press the Send (double arrows) key to select the option.  You will see the current
session ID and will be asked if you want to change the session ID.  Press T (Yes) to
change.  Enter the session ID and press the Send (double arrows) key to send.

· For Q5RF remotes-wait for the remote to say "No Net," "Not Active," or "Not Found."
Press the Menu key and select Enter Session ID using the Send (double arrows) key or
the circle key on the thumb pad.  Enter the session ID and press the Send (double
arrows) key.

Logging in with Participant IDs
Participant IDs can only be numeric.

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Click on the Login tab.
3. Select "Require Login by ID."
4. Select the participant list and any other options you want to apply to the

presentation.
5. Click OK to begin the presentation.
6. The remotes will display "User ID."
7. Enter the participant ID and press the Send (double arrows) key.
8. If a remote says "Access Denied" or "Denied," then the participant ID may have been

entered incorrectly.
· For Q2RF, when you see "--U," enter the participant ID and press Send.
· For Q4RF remotes, press the Menu key, use the right arrow to scroll to User ID,

and press the Send (double arrows) key to select it.  Re-enter the participant
ID and press the Send (double arrows) key.

· For Q5RF remotes, press the C (clear) key, re-enter the participant ID, and
press the Send (double arrows) key.

The participant IDs will be remembered for the session until another participant list is
selected to present to.

Using Multiple Hosts
Up to 16 hosts (with 1000 remotes on each) can be used for presentation for Q4RF and
Q5RF.
If you have selected to use fixed set, be sure you have assigned fixed numbers for the
remotes using all RF hosts.

1. Click on the  Present button.  The Presentation Setup window will appear.
2. Click on the Login tab.
3. Select the hosts you will be using by placing a check mark in each one of the

boxes.
4. You can create your own session ID in the User Session column or use the default

session ID.

If you use the default session ID in the  Host Session column, the User Session
column must be blank.
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5. Click on OK to begin the presentation.
6. When the presentation appears, turn on the remotes.
7. If you assigned fixed numbers, the remotes will automatically log into the correct

host, using the session IDs used at that time.
8. Enter the appropriate session IDs into the remotes (including instructor) if

prompted to do so and press the Send (double arrows) key.  Press the C (clear) key
to delete if you accidentally mistyped a number or see Changing Session IDs
above for more information.

9. At this time, the remote should display the question answer choices or it may
display "Qwizdom" and the remote number.

10.    Below are other things the remotes may display:
· The instructor remote will say "Ready" or "Last Key."
· If the remotes say "Qwizdom" and display their remote number, they are

ready and waiting for a question slide to appear.  Remotes can only respond
when the slides are remote-answerable such as Multiple Choice, True/False,
Numeric, etc.

· The LCD screen on the participant remotes may read "Push Key," "Inactive," or
"Not Active,"  press the Send (double arrows) key to "wake up" the remote.

· If the remotes say "No Net" or "Host not found," re-enter the Session ID.
· If the remotes say "Denied" or "Access Denied," this could be that the

participant/user ID is incorrect, or the remote number attempting to
participate isn't in the participant list that was loaded.  Re-enter the
participant/user ID, and check to make sure that remote number is in the
participant list.

· If the Q2RF displays "- - -," the remote could not find an active host and will
automatically turn off. Turn remote back on and press the Help key to enter
the correct Session ID.

If the remotes continue say "No Net" and will not establish a connection to the host, go to
Initializing the Host to get the host to initialize.  If you need further help, please contact
Technical Support.

11.1 Notice

FCC 15.19:

(3)  All other devices shall bear the following statement in a conspicuous
location on the device.

This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) this device may not cause harmful
interference, ad (2) this device must accept any interference received,
including interference that may cause undesired operation.
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FCC 15.21:
The users manual or instruction manual for an intentional or unintentional
radiator shall caution the user that changes or modifications not expressly
approved by the party responsible for compliance could void the user's
authority to operate the equipment. In cases where the manual is provided
only in a form other than paper, such as on a computer disk or over the
Internet, the information required by this section may be included in the
manual in that alternative form, provided the user can reasonably be
expected to have the capability to access information in that form.

FCC 15.105:

(b) For a Class B digital device or peripheral, the instructions furnished the
user shall include the following or similar statement, placed in a prominent
location in the text of the manual:

NOTE:  This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is not guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

-- Reorient or relocate the receiving antenna.
-- Increase the separation between the equipment and receiver.
-- Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.
-- Consult the dealer or an experienced radio/TV technician for help.

11.2 Q2RF

Participant Remote
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1. E inkä display-displays the remote's ID number when it is turned off; displays
remote's ID number and battery icon when it is turned on.

2. Navigation  arrows-to scroll through question numbers. Left arrow 
is also used as a backspace.

3. True/Yes, False/No keys-use to answer True/False and Yes/No questions
4. Multiple Choice and Numeric keypad-answer multiple choice and numeric

questions (with single digit answers).

5. Send  key-press to turn remote on/off or confirm Session and/or User IDs.

6. Help  key-press to request assistance or press to change Session ID when the
remote cannot find the host.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
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11.3 Q4RF

Participant Remote

     

1. Send  key-press to submit answer or select menu options.

2. Menu [power] key-press to view menu options (use the scroll  keys to

scroll through options and press Send  key to select the option).  Holding the
Menu button for two seconds will turn the remote on/off.  Turn off remotes if they
are not in use.  Remotes automatically turn off at the end of a PowerPoint
presentation.  Search, Sess. ID, User ID, and Exit are options available in the Menu.
When you're in presentation, the menu items are Help, Login User Id, and Exit.  To
request help during presentation, press the Menu key, scroll to select Help, and

press the Send  key to select it.

3. Scroll  keys-to scroll through menu options, answer choices, or question
numbers.

4. Clear [C] key-press to delete response or change answers if instructor has enabled
the feature.
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5. True/Yes and False/No keys--use to answer True/False and Yes/No questions
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

11.4 Q5RF

Participant Remote

1. Send  key-press to submit answer
2. Clear [C] key-press to delete response or change an answer in a presentation (if

option to change responses is allowed)
3. Thumb pad-press to navigate between letters when keying in answer, press the

circle button in the middle to select a letter or to select menu options or to scroll
through question numbers during answer keys (paper-based tests).

4. Question [?] key-signals help to instructor during presentation
5. Menu key-displays menu options Search Again, Enter Session ID, and Exit.  Use the

thumb pad to scroll through the menu options and the Send  key or circle
button to select an option.

6. True/Yes and False/No keys-use to answer True/False and Yes/No questions
7. Power switch-turns remote on/off.  The remotes do not automatically turn off.

Turn off remotes if they are not in use.
8. Light switch-turns Backlight on/off

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
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Instructor Remote (this is the instructor remote for Q4 and Q5 participant remotes)

1. Send  key-press to submit command
2. C [Clear] key-press to clear names from the Help Request list.
3. Thumb pad-press right/left to navigate between slide sets, up/down for menu

options, and "on-the-fly" question choices.  Press the circle button (in the middle)
to select an option, play Microsoft PowerPoint animations, advance slides, exit the
presentation, and show/hide correct responses on the response graph.

4.   ? [Help List] key-displays list of participants who requested help on the LCD screen
5. Menu key-view menu options such as entering session ID and search again for

host
6. True/Right and False/Wrong keys-not applicable using Qwizdom Actionpoint
7. New Q [-] key-press to pose an "on-the-fly" question
8. Pick [.] key-press to display/hide a random participant's name on the computer

screen

9. LCD Graph  [0] key-displays the results of the class responses as a graph on the
LCD screen of the instructor's remote

10. Screen Graph  [/] key-displays the results of the class responses as a graph on
the computer (projector, television screen, etc.) screen for everyone to view.  Use
the right/left controls on the thumb pad to scroll through the different graphs.
Use the circle button (in middle of thumb pad) to show/hide correct responses.

11. Show [7] key-not applicable using Qwizdom Actionpoint
12. Play [8] key-pauses or continues a video/sound clip
13. Fn (Function) key-allows you to re-pose a question if you go back during to a
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previous slide during presentation-previous answers will be overwritten.
14. Power switch-turns remote on/off
15. Light switch-turns Backlight on/off.  The "Enable Backlight" box in the Configuration

Settings window needs to be checked to turn on the Backlight feature.
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

11.5 Q7RF

Instructor Tablet
Available Fall 2008

The Q7RF Instructor Tablet* acts as an absolute position mouse, controlling standard
keyboard shortcuts such as:

· copy, paste, and delete
· navigating presentations

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
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Pen (for Q7RF Instructor Tablet)
Available Fall 2008

The Pen* is used as a mouse that can left-click, right-click, and double-click to execute
commands/actions on the Q7RF Instructor Tablet.
*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

RF Host (for Instructor Tablet)
Available Fall 2008

The RF Host* is plugged into the computer to collect data from the RF remotes and
recorded into the software program.
*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

11.6 Using Remotes in Presentation

Instructor Remote Tips
· The Q5RF instructor remote will say "Ready" or "Last Key.

· Since the Q5RF remote is not applicable during answer keys, the LCD screen will
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display "Access Denied."

· Press the / key on the RF instructor remote to display the response graph.

· Press the / key on the RF instructor remote to close the response graph.

· Press the 0 key on the RF instructor remote to display the graph on the instructor's
LCD.

· Press the Pick (.) key on the RF instructor remote to randomly call upon a participant
during presentation.

· Press the Play (8) key on the RF instructor remote to play/stop movie or sound on
slide.

· Press the Show (7) key on the RF instructor remote to show current scores of
participants/group during game mode.

· Press the New Q (-) key to pose a spontaneous question. A list of question types will
appear on the LCD. Use the up/down arrows on the thumb pad to navigate
through the question types. Press the Send key to select the question type. Select
the correct answer and press Send; or the answer is survey only, press the Send key
without selecting an answer.

· Press the ? key to display the list of participants who have requested help.

· Press the circle key, in the thumb pad, to close out of the presentation (must be on
last slide), play the PowerPoint animation and schemes (if any were applied), move
to the next slide, or displays/hides the correct answer on response graph

Participant Remote Tips
· "Qwizdom" will be displayed on the Q4RF and Q5RF remotes when a lesson (non-

question) slide is in view.

· On Q4RF and Q5RF remotes, participants will either see answer choices or a blank
screen (depending on question type) on their remote during a question slide.

· To request help; on the Q4RF/Q5RF remote, press the Menu key to select Help and
press Send on the remote to request for help.

· To change the Session ID on the Q4RF remote, press the Menu key and use the right
arrow to scroll through the menu options. When you see Sess. ID, press the Send key
to select it. An existing session ID may appear and the remote will ask if you want to
change it. Press T for yes and enter the new session ID. Press the Send key to
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confirm.

· To change the Session ID on the Q5RF remote, press the Menu key when the
remote displays "No Host Found." Use the thumb pad to navigate through the menu
options and press the Send key to select Enter Session ID.

· To change the user ID on the Q4RF remote, press the Menu key and use the right
arrow key to scroll to User ID. An existing user ID may appear and the remote will
ask if you want to change it. Press T for yes and enter a user ID. Press the Send key to
confirm.

· The LCD screen on the Q4RF and Q5RF remotes may display "Push Key," "Inactive," or
"Not Active,"  press the Send (double arrows) key to 'wake up' the remote.  If the
remote still says "Not Active," re-enter the session ID.

· If the Q4RF and/or Q5RF remotes say "No Net" or "Host not found," re-enter the
session ID.  Go to Changing Session IDs for more information.

· If the Q4RF and/or Q5RF remotes say "Denied" or "Access Denied," the participant ID
is incorrect, or the remote number attempting to participate isn't in the participant
list that was loaded.  Re-enter the participant ID, and check to make sure that
remote number is in the participant list.

· To change the Session ID on the Q2RF remote, wait for the remote to display " - - -,"
and then it will automatically turn off. Turn the remote back on and press the Help
key. When "--S" displays, enter the correct Session ID and press the Send key.

· The Q2RF is searching for an active host when it displays  "-  -" and then " - " for a few
moments.

· "--U" indicates the Q2RF is asking for the participant/user ID.

· "--S" indicates the Q2RF is asking for the Session ID.

Below are the procedures on how to respond for each question type during presentation:
· True/False; select T or F and press the Send key.

· Yes/No; select Y or N and press the Send key.

· Multiple Choice; select A, B, C, D, E, or F and press the Send key.

· Multiple Mark; select the letter choices and press the Send key.

· Numeric; enter the number(s) and press the Send key.
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· Sequence; enter the numbers in the order and press the Send key.

· Multiple Answer-List; press the letter choices and press the Send key.

· Fill-in/Completion; for Q5 remotes only-for one answer you will see:
1)___________________
*)Send
Make sure 1) is highlighted and press either the Circle or the Send key to select it.
1)_______________ will appear on the LCD. Press the Menu key to display the
alphabet. Use the arrows on the thumb pad to navigate through the letters, using
the Circle key to select the letter(s). Press the Send key when finished entering the
answer. You will see 1)your answer. Press the down arrow on the thumb pad to
select *)Send and press the Send key to confirm the answer.
For two answers, you will see:

1)___________________
2)___________________
*)Send

Make sure 1) is highlighted and press either the Circle or the Send key to select the
question number. 1)__________ will appear on the LCD. Press the Menu key to
display the alphabet. Use the arrows on the thumb pad to navigate through the
letters, using the Circle key to select the letter(s). Press the Send key when finished
entering the answer. You will see 1)your answer.
Press the down arrow on the thumb pad to select 2)__________ and press the Circle
or Send key to select the question number. 2)__________ will appear on the LCD.
Press the Menu key to display the alphabet. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key when finished entering the answer. You will see 2)your answer.
Press the down arrow on the thumb pad to select *)Send and press the Send key to
confirm the answers.

· Short Answer/Text Input; for Q5 remotes only. The alphabet menu will
automatically appear when this question type is displayed. Use the arrows on the
thumb pad to navigate through the letters, using the Circle key to select the letter(s).
Press the Send key to confirm your answer. 

12 Troubleshoot

12.1 Uninstalling Software and Hardware

Uninstalling Qwizdom Connect
Before uninstalling, be sure to export any activities, classes, etc. saved within Qwizdom
Connect before uninstalling, otherwise they will be deleted.
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1. Go to Add/Remove programs in the Control Panel.
2. Search for Qwizdom Connect  and click Remove.
3. The InstallShield wizard will appear and follow the instructions.
4. Restart your computer for the changes to take affect.

Uninstalling USB Drivers
If the host is still not initializing after following the steps above, then the hardware needs
to be completely removed and then reinstalled.  Follow the steps below.

1. Go to your Control Panel from either your Settings or Start menu.
2. Double-click on System and click on the Hardware tab or Device Manager tab.  If

you go to the Hardware tab, click on the Device Manager button.
3. Search for the Qwizdom RF Host under Universal Serial Bus Controllers, Ports, and/or

Other or Unknown Devices.
4. Double-click on the file and click on the Driver tab.
5. Select Uninstall.
6. Unplug your host after it is uninstalled and go back to the Control Panel.
7. Double-click on Add or Remove Programs and search for FTDI Universal Serial

Converter Drivers.
8. When you find it, remove the file.
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